
Self-Service Script
DRAFT
6/4/2002

Script Name Self-Service
Description This script regression tests the functionality that was delivered in Release I, and tests the 

additional functionality that was developed for Release II.
Created By Heather Towhidian
Prerequisites N/A
Outputs
Use Cases Covered Email, Self-Service

Step: Value to Enter Expected Results Actual 
Results

Pass/Fail SIR# Test Conditions

Log-in to FISAP on the Web as Commonwealth 
Business College

1 Open Internet Explorer Browser from Desktop Browser opens
2 Type in URL <http://dev.cbs.sfa.ed.gov:8531> into 

address line
Network Password Login Box appears

3 Type <cbs> as your  username and <cbstest> as your 
password

Field accepts value (this step is for test purposes only and will not be necessary in 
September)

4 Click <ok> Login Screen Appears
5 Click <Log in> button Network Password Login Box appears
6 Type <integrate> as your username and <pin1026> 

as your password
Field accepts value (this step is for test purposes only and will not be necessary in 
September)

7 Click <ok> Login Screen Appears
8 Click <Log in> button Security message is displayed  - if browser is set that way
9 Type in <777777777> to the SSN field Field accepts value

10 Type in <Po> into the last two digits of your last 
name fields

Field accepts value

11 Type in  <10221970> in the DOB field Field accepts value
12 Type in <2292> in the PIN field Field accepts value
13 Click  <submit request> System displays the TG screen
14 Click <yes> or appropriate button to agree with the 

statement
System displays the Pin-Site Confirming Your Identity screen

15 Enter <TG77777> into the TG # field Field accepts value
16 Click <Next> The System displays the Change Schools page of the Setup section. There is a dropdown 

menu with a list of schools available to the User. Single school users will only see one 
school in the dropdown menu. There is a Change Schools button and a Help button.  
There is a submenu that lists options available to the User. These options vary depending 
on the User’s privileges. For read/write/submit Users this submenu lists Change Schools, 
Reallocation Form, Funding Levels, File Management, Administration, and Work-
Colleges.      n.b (You may need to click <Yes> if a security dialogue box appears)

17 Select <007172 Commonwealth Business College> 
from the dropdown box

System selects the desired School
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Step: Value to Enter Expected Results Actual 
Results

Pass/Fail SIR# Test Conditions

18 Click <Change Schools> button System displays School: Commonwealth Business College   Serial #: 007172 on the Setup - 
Change Schools page

19 User Wants to Test Self-Service Links and Print 
Documents

20 Select the <Self-Service> button located on the top 
navigation bar.

The Self-Service page is displayed.  The page contains three headings - Forms & Reports, 
Campus Based Notifications,  Acknowledgements and Contact Help Desk.
Forms & Reports contains 
This Year's FISAP Form       
Submitted Version - All Parts | Part 1 | Part 2 | Part 3 | Part 4 | Part 5 | Part 6   (PDF)    
Current Working Version - All Parts | Part 1 | Part 2 | Part 3 | Part 4 | Part 5 | Part 6     
(PDF)  
Submitted Version - Branch Campus | Additional Information   
Current Working Version - Branch Campus | Additional Information   
Debarment Form & Signature Page   (PDF)   
Lobbying Form    (PDF)  
Statement of Account - 2001-2002 | 2000-2001 | 1999-2000 | 1998-1999 | 1997-1998   
Campus-Based Notifications
(This is dynamic based on School)
Acknowledgements
Submission Log   
Batch Submittal  
Contact Help Desk
CB Call Center CBFOB@ed.gov      (877) 801-7168  
 IFAP Web Page      http://ifap.ed.gov/ 

21 Select <All Parts> from the Forms & Reports section 
under "This Year's FISAP Form, Current Working 
Version."

A new window will open and display the document via the Adobe Acrobat Reader.

22 Select <File> from the .pdf menu File Menu is displayed
23 Select <Print> Option The Print Menu is displayed
24 Select <Pint> button The Report is printed
25 Select <Close> button The Report closes
26 Close the new window by clicking the <Back> on the 

browser
The new window closes.  The Self-Service Page is displayed.

27 Select <Part 1> from the Forms & Reports section 
under "This Year's FISAP Form, Current Working 
Version."

A new window will open and display the document via the Adobe Acrobat Reader.

28 Select <File> from the .pdf menu File Menu is displayed
29 Select <Print> Option The Print Menu is displayed
30 Select <Pint> button The Report is printed
31 Close the new window by clicking the <Back> on the 

browser
The new window closes.  The Self-Service Page is displayed.
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Results
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32 Select <Part 2> from the Forms & Reports section 
under "This Year's FISAP Form, Current Working 
Version."

A new window will open and display the document via the Adobe Acrobat Reader.

33 Select <File> from the .pdf menu File Menu is displayed
34 Select <Print> Option The Print Menu is displayed
35 Select <Pint> button The Report is printed
36 Close the new window by clicking the <Back> on the 

browser
The new window closes.  The Self-Service Page is displayed.

37 Select <Part 3> from the Forms & Reports section 
under "This Year's FISAP Form, Current Working 
Version."

A new window will open and display the document via the Adobe Acrobat Reader.

38 Select <File> from the .pdf menu File Menu is displayed
39 Select <Print> Option The Print Menu is displayed
40 Select <Pint> button The Report is printed
41 Close the new window by clicking the <Back> on the 

browser
The new window closes.  The Self-Service Page is displayed.

42 Select <Part 4> from the Forms & Reports section 
under "This Year's FISAP Form, Current Working 
Version."

A new window will open and display the document via the Adobe Acrobat Reader.

43 Select <File> from the .pdf menu File Menu is displayed
44 Select <Print> Option The Print Menu is displayed
45 Select <Pint> button The Report is printed
46 Close the new window by clicking the <Back> on the 

browser
The new window closes.  The Self-Service Page is displayed.

47 Select <Part 5> from the Forms & Reports section 
under "This Year's FISAP Form, Current Working 
Version."

A new window will open and display the document via the Adobe Acrobat Reader.

48 Select <File> from the .pdf menu File Menu is displayed
49 Select <Print> Option The Print Menu is displayed
50 Select <Pint> button The Report is printed
51 Close the new window by clicking the <Back> on the 

browser
The new window closes.  The Self-Service Page is displayed.

52 Close the new window by clicking the <x> button 
located on the upper-right corner of the window.

Close the new window by clicking the <x> button located on the upper-right corner of the 
window.

53 Select <Part 6> from the Forms & Reports section 
under "This Year's FISAP Form, Current Working 
Version."

A new window will open and display the document via the Adobe Acrobat Reader.

54 Select <File> from the .pdf menu File Menu is displayed
55 Select <Print> Option The Print Menu is displayed
56 Select <Pint> button The Report is printed
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57 Close the new window by clicking the <Back> on the 
browser

The new window closes.  The Self-Service Page is displayed.

58 Close the new window by clicking the <x> button 
located on the upper-right corner of the window.

The new window closes.  The Self-Service Page is displayed.

59 Select <All Parts> from the Forms & Reports section 
under "This Year's FISAP Form, Submitted Version."

A new window will open and display the document via the Adobe Acrobat Reader.

60 Select <File> from the .pdf menu File Menu is displayed
61 Select <Print> Option The Print Menu is displayed
62 Select <Pint> button The Report is printed
63 Close the new window by clicking the <Back> on the 

browser
The new window closes.  The Self-Service Page is displayed.

64 Select <Part 1> from the Forms & Reports section 
under "This Year's FISAP Form, Submitted Version."

A new window will open and display the document via the Adobe Acrobat Reader.

65 Select <File> from the .pdf menu File Menu is displayed
66 Select <Print> Option The Print Menu is displayed
67 Select <Pint> button The Report is printed
68 Close the new window by clicking the <Back> on the 

browser
The new window closes.  The Self-Service Page is displayed.

69 Select <Part 2> from the Forms & Reports section 
under "This Year's FISAP Form, Submitted Version."

A new window will open and display the document via the Adobe Acrobat Reader.

70 Select <File> from the .pdf menu File Menu is displayed
71 Select <Print> Option The Print Menu is displayed
72 Select <Pint> button The Report is printed
73 Close the new window by clicking the <Back> on the 

browser
The new window closes.  The Self-Service Page is displayed.

74 Select <Part 3> from the Forms & Reports section 
under "This Year's FISAP Form, Submitted Version."

A new window will open and display the document via the Adobe Acrobat Reader.

75 Select <File> from the .pdf menu File Menu is displayed
76 Select <Print> Option The Print Menu is displayed
77 Select <Pint> button The Report is printed
78 Close the new window by clicking the <Back> on the 

browser
The new window closes.  The Self-Service Page is displayed.

79 Select <Part 4> from the Forms & Reports section 
under "This Year's FISAP Form, Submitted Version."

A new window will open and display the document via the Adobe Acrobat Reader.

80 Select <File> from the .pdf menu File Menu is displayed
81 Select <Print> Option The Print Menu is displayed
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82 Select <Pint> button The Report is printed
83 Close the new window by clicking the <Back> on the 

browser
The new window closes.  The Self-Service Page is displayed.

84 Select <Part 5> from the Forms & Reports section 
under "This Year's FISAP Form, Submitted Version."

A new window will open and display the document via the Adobe Acrobat Reader.

85 Select <File> from the .pdf menu File Menu is displayed
86 Select <Print> Option The Print Menu is displayed
87 Select <Pint> button The Report is printed
88 Close the new window by clicking the <Back> on the 

browser
The new window closes.  The Self-Service Page is displayed.

89 Select <Part 6> from the Forms & Reports section 
under "This Year's FISAP Form, Submitted Version."

A new window will open and display the document via the Adobe Acrobat Reader.

90 Select <File> from the .pdf menu File Menu is displayed
91 Select <Print> Option The Print Menu is displayed
92 Select <Pint> button The Report is printed
93 Close the new window by clicking the <Back> on the 

browser
The new window closes.  The Self-Service Page is displayed.

94 Select <Submitted Version-Branch Campus 
Additional Information> 

The System displays the Submitted Version-Branch Campus Additional Information Page

95 Select <File> from the .pdf menu File Menu is displayed
96 Select <Print> Option The Print Menu is displayed
97 Select <Pint> button The Report is printed
98 Select <Current Working Version-Branch Campus 

Additional Information> 
The System displays the Current Working Version-Branch Campus Additional 
Information Page

99 Select <File> from the new window's top navigation 
bar

The File Menu is displayed

100 Select <Print> from the file menu The System prints the page
101 Select <Debarment Form & Signature Page> from 

the Forms & Reports section.
The System displays the Debarment and Signature Page

102 Select <File> from the .pdf menu File Menu is displayed
103 Select <Print> Option The Print Menu is displayed
104 Select <Pint> button The Report is printed
105 Close the new window by clicking the <x> button 

located on the upper-right corner of the window.
The new window closes.  The Self-Service Page is displayed.

106 Select <Lobbying Form> from the Forms & Reports 
section.

A new window will open and display the document via the Adobe Acrobat Reader.

107 Close the new window by clicking the <x> button 
located on the upper-right corner of the window.

The new window closes.  The Self-Service Page is displayed.

5



Self-Service Script
DRAFT
6/4/2002

Step: Value to Enter Expected Results Actual 
Results

Pass/Fail SIR# Test Conditions

108 Select <2001-2002> from the Forms & Reports 
section under Statement of Account.

A new window will open and display the document via the Adobe Acrobat Reader.

109 Close the new window by clicking the <x> button 
located on the upper-right corner of the window.

The new window closes.  The Self-Service Page is displayed.

110 Select <2000-2001> from the Forms & Reports 
section under Statement of Account.

A new window will open and display the document via the Adobe Acrobat Reader.

111 Select <File> from the new window's top navigation 
bar

The File Menu is displayed

112 Select <Print> from the file menu The System prints the page
113 Close the new window by clicking the <x> button 

located on the upper-right corner of the window.
The new window closes.  The Self-Service Page is displayed.

114 Select <1999-2000> from the Forms & Reports 
section under Statement of Account.

A new window will open and display the document via the Adobe Acrobat Reader.

115 Select <File> from the new window's top navigation 
bar

The File Menu is displayed

116 Select <Print> from the file menu The System prints the page
117 Close the new window by clicking the <x> button 

located on the upper-right corner of the window.
The new window closes.  The Self-Service Page is displayed.

118 Select <1998-1999> from the Forms & Reports 
section under Statement of Account.

A new window will open and display the document via the Adobe Acrobat Reader.

119 Close the new window by clicking the <x> button 
located on the upper-right corner of the window.

The new window closes.  The Self-Service Page is displayed.

120 Select <1997-1998> from the Forms & Reports 
section under Statement of Account.

A new window will open and display the document via the Adobe Acrobat Reader.

121 Close the new window by clicking the <x> button 
located on the upper-right corner of the window.

The new window closes.  The Self-Service Page is displayed.

122 Select <Submission Log> from the 
Acknowledgements section.

A new window will open and display the document via the Adobe Acrobat Reader.

123 Close the new window by clicking the <x> button 
located on the upper-right corner of the window.

The new window closes.  The Self-Service Page is displayed.

124 Select <Batch Submittal> from the 
Acknowledgements section.

A new window will open and display the document via the Adobe Acrobat Reader.

125 Close the new window by clicking the <x> button 
located on the upper-right corner of the window.

The new window closes.  The Self-Service Page is displayed.
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126 Select the <CBFOB@ed.gov > link in the Contact the 
Help Desk section.  The link is located in the "Email" 
column.

The system activates the User's mail utility.  "CBFOB@ed.gov" is populated in the 
Recipient field.

127 Close the mail utility by clicking the <x> button 
located on the upper-right corner of the window.

The email utility closes.  The Self-Service Page is displayed.

128 Select the <http://ifap.ed.gov/> link in the Contact 
the Help Desk section.  The link is located in the 
"Email" column.

A new window will open and display the IFAP web page.  "www.IFAP.ed.gov" is 
populated as the URL.

129 Close the mail utility by clicking the <x> button 
located on the upper-right corner of the window.

The email utility closes.  The Self-Service Page is displayed.

130  Log in to Admin Site
131 Enter 

<http://dev.cbs.sfa.ed.gov:8531/CBSWebApp/adm
in/adminWelcome.jsp> into the browser address 
window

Window "Enter Network Password", asking for user's name and password is displayed.  
(Testing only)

132 Type <cbs> as your username and <cbstest> as your 
password

Field accepts values

133 Click <OK> Verify that the system displays the Campus-Based Admin Login page. In the center of the 
page is a Login button. There is a following instruction notifying the Admin User how to 
proceed:   Welcome to Campus-Based Administration. 

To access the Campus-Base

  

134 Select <Log In> button Network login screen appears.
135 Type <integrate> as your username and <pin1026> 

as your password
Field accepts value (this step is for testing purposes only and will not be necessary in 
February).

136 Select <OK> or if security browser was displayed, 
click <Yes> button to accept

 The System displays the PIN Authentication site with the following fields: social security 
number, first two letters of last name, date of birth, and PIN. The PIN Authentication site 
is outside of the eCB System. 

137 Enter <222334444> into the SSN field Field accepts value.
138 Enter <IM> into the first two letters of last name 

field
Field accepts value.

139 Enter <10221970> in the DOB field Field accepts value.
140 Enter <2309> in the PIN number field. Field accepts value.
141 Select <Submit Request> button Security Alert message comes up.
142 Select <Yes> button The System displays a screen where the Admin User enters the Admin TG number. There 

is a field to enter a TG number. There is a Next button. There is a following instruction 
notifying the Admin User how to proceed: "Please enter your TG number using upper

143 Enter <TG08899> into the TG field Field accepts value.
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144 Click <Next> button  The System displays the Campus-Based Admin home page. The following links are 
displayed on the left navigation bar: Accounting, Admin Security, Awards, ComLog, 
Communications, FISAP Update, FISAP View, Hold Schools, Manual Adjustments, New 
Schools, PART, PLIST, Recalculation, Reports, Tracking, Waivers, Work College, Log Out

145 Admin User Updates Email Text
146 Select the <Communication> Link from the left 

navigation bar
The System displays the Communications page. There are links to all e-mails available for 
the current year. Next to each message is a radio button. There is no default radio button. 
Each option is also a link to a report version of the message text. There is an Edit button. 
There is a dropdown menu where the Admin User can select a year. Initially only one year 
is available. Upon succeeding years, the Admin User can access the prior data up to five 
years. There is a dropdown menu where the Admin User selects a year. There is a Select 
button. There is an instruction notifying the Admin User how to proceed. 

EM007, EM003

147 Select the <radio button> next to the Final Awards e-
mail link

A block dot is displays EM008

148 Select <2001> from dropdown menu The system displays 2001
149 Select the <Edit> Button on the bottom of the page The System displays the Communications – Edit E-mail Text page. The text of the message 

is in an input box. The existing text prepopulates this input box. There is an Update 
button. There is an instruction notifying the Admin User how to proceed.  The text reads:

[MM/DD/YYYY]

Dear [FAA]: 
The U.S. Department of Education's eCampus-Based System has determined your school's 
final funding authorization for the Federal Perkins Loan, Federal Work-Study (FWS), 
and/or Federal Supplemental Educational Opportunity Grant (FSEOG) programs for the 
2002-2003 award year.

To review details of your notification, please logon to the eCampus-Based System web site 
at www.cbfisap.sfa.ed.gov. Select the "Self Service" link from the top navigation bar or 
main menu. Your data is posted in the "Campus-Based Notifications" section.

Sincerely,

The Campus-Based Programs
 
 

 


EM010
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150 Enter <Is Testing Final Award Email Notification> in 
the underlined snippet.

Field displays value EM010

151 Select the <Update> button on bottom of the Page The System displays the Communications page. EM009

152 Select the <Final Awards> link The System displays a report showing the updated text. EM011, EM009
153 Select <File> from the .pdf menu File Menu is displayed
154 Select <Print> Option The Print Menu is displayed
155 Select <Pint> button The Report is printed
156 Select <Close> button The Report closes
157 Admin User Views the Text for each E-mail
158 Select the <Tentative Award Notification> link on 

the Communications page
The e-mail displays:

[mm/dd/yyyy]  
Dear [FAA]:  
The U.S. Department of Education’s eCampus-Based System has determined your school’s 
tentative funding levels for the Federal Perkins Loan, Federal Work-Study (FWS), and/or 
Federal Supplemental Educational Opportunity Grant (FSEOG) programs for the [2002-
2003] award year. 

To review details of your notification, please logon to the eCampus-Based System web site 
at www.cbfisap.sfa.ed.gov. Select the “Self Service” link from the top navigation bar or 
main menu.  Your data is posted in the “Campus-Based Notifications” section.    

Sincerely,  
The Campus-Based Programs  

EM004, EM005

159 Select the <Close> button The report closes and the system displays the Communications page EM006
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168 Select the <Close Out Awards> link on the 
Communications page

The e-mail displays:
[MM/DD/YYYY]

Dear [FAA]: 
The U.S. Department of Education's eCampus-Based System has completed the closeout of 
all 2000-2001 Campus-Based awards.

To review details of your notification, please logon to the eCampus-Based System web site 
at www.cbfisap.sfa.ed.gov. Select the "Self Service" link from the top navigation bar or 
main menu. Your data is posted in the "Campus-Based Notifications" section.

Sincerely,

The Campus-Based Programs

EM004, EM005

169 Select the <Close> button The report closes and the system displays the Communications page EM006
168 Select the <Supplemental Awards> link on the 

Communications page
The e-mail displays:

[MM/DD/YYYY]

Dear [FAA]: 
The U.S. Department of Education's eCampus-Based System has determined your school's 
supplemental funding for the 2001-2002 award year. Your Statement of Account serves as 
your notification.

To review details of your notification, please logon to the eCampus-Based System web site 
at www.cbfisap.sfa.ed.gov. Select the "Self Service" link from the top navigation bar or 
main menu. Your data is posted in the "Campus-Based Notifications" section.

Sincerely,

The Campus-Based Programs

EM004, EM005

169 Select the <Close> button The report closes and the system displays the Communications page EM006
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160 Select the <Perkins Teacher Cancellation Award 
Notification> link on the Communications page

The e-mail displays:

[MM/DD/YYYY]

Dear [FAA]: 
The U.S. Department of Education's eCampus-Based System has determined your school's 
Perkins Loan Service Cancellation payment letter and worksheet for reimbursement of the 
2002-2003 award year.

To review details of your notification, please logon to the eCampus-Based System web site 
at www.cbfisap.sfa.ed.gov. Select the "Self Service" link from the top navigation bar or 
main menu. Your data is posted in the "Campus-Based Notifications" section.

Sincerely,

The Campus-Based Programs

EM004, EM005

161 Select the <Close> button The report closes and the system displays the Communications page EM006
162 Select the <Hold School> link on the 

Communications page
The e-mail displays:

[MM/DD/YYYY]

Dear [FAA]: 
The U.S. Department of Education's eCampus-Based System has placed your school's final 
funding for the 2002-2003 award year on Hold.

To review details of your notification, please logon to the eCampus-Based System web site 
at www.cbfisap.sfa.ed.gov. Select the "Self Service" link from the top navigation bar or 
main menu. Your data is posted in the "Campus-Based Notifications" section.

Sincerely,

The Campus-Based Programs
 
 

 


EM004, EM005

163 Select the <Close> button The report closes and the system displays the Communications page EM006
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164 Select the <Safeguard Procedure Notifications> link 
on the Communications page

Email Displays:  MM/DD/YYYY]

Dear [FAA]: 
The U.S. Department of Education's eCampus-Based System has reviewed and responded 
to your school's Safeguard Procedures Report. Please forward this e-mail notification to 
the IRS Skiptracing Service contact at your school.

To review details of your notification, please logon to the eCampus-Based System web site 
at www.cbfisap.sfa.ed.gov. Select the "Self Service" link from the top navigation bar or 
main menu. Your data is posted in the "Campus-Based Notifications" section.

Sincerely,

The Campus-Based Programs

165 Select the <Close> button The report closes and the system displays the Communications page
166 Select the <Safeguard Activity Notifications> link on 

the Communications page
Email Displays: 
MM/DD/YYYY]

Dear [FAA]: 
The U.S. Department of Education's eCampus-Based System has reviewed and responded 
to your school's Safeguard Activity Report. Please forward this e-mail notification to the 
IRS Skiptracing Service contact at your school.

To review details of your notification, please logon to the eCampus-Based System web site 
at www.cbfisap.sfa.ed.gov. Select the "Self Service" link from the top navigation bar or 
main menu. Your data is posted in the "Campus-Based Notifications" section.

Sincerely,

The Campus-Based Programs

167 Select the <Close> button The report closes and the system displays the Communications page
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166 Select the <ELC 1 Notification Letter> link on the 
Communications page

The e-mail displays:
MM/DD/YYYY]

Dear [FAA]: 
The U.S. Department of Education's eCampus-Based System has reason to believe that 
your Federal Perkins Loan Program Fund may contain more money than your school 
requires for expenditures in the foreseeable future.
To review details of your notification, please logon to the eCampus-Based System web site 
at www.cbfisap.sfa.ed.gov. Select the "Self Service" link from the top navigation bar or 
main menu. Your data is posted in the "Campus-Based Notifications" section.

Sincerely,

The Campus-Based Programs

EM004, EM005

167 Select the <Close> button The report closes and the system displays the Communications page EM006
168 Select the <ELC 2 Notification Letter> link on the 

Communications page
The e-mail displays:
MM/DD/YYYY]

Dear [FAA]: 
The U.S. Department of Education's eCampus-Based System has reason to believe that 
your Federal Perkins Loan Program Fund may contain more money than your school 
requires for expenditures in the foreseeable future.
To review details of your notification, please logon to the eCampus-Based System web site 
at www.cbfisap.sfa.ed.gov. Select the "Self Service" link from the top navigation bar or 
main menu. Your data is posted in the "Campus-Based Notifications" section.

Sincerely,

The Campus-Based Programs

EM004, EM005

169 Select the <Close> button The report closes and the system displays the Communications page EM006
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168 Select the <ELC 3 Notification Letter> link on the 
Communications page

The e-mail displays:
MM/DD/YYYY]

Dear [FAA]: 
The U.S. Department of Education's eCampus-Based System has reason to believe that 
your Federal Perkins Loan Program Fund may contain more money than your school 
requires for expenditures in the foreseeable future.
To review details of your notification, please logon to the eCampus-Based System web site 
at www.cbfisap.sfa.ed.gov. Select the "Self Service" link from the top navigation bar or 
main menu. Your data is posted in the "Campus-Based Notifications" section.

Sincerely,

The Campus-Based Programs

EM004, EM005

169 Select the <Close> button The report closes and the system displays the Communications page EM006
170 Select the <ELC Second Notification Letter> link on 

the Communications page
The e-mail displays:  [MM/DD/YYYY]

Dear [FAA]: 
The U.S. Department of Education's eCampus-Based System has not yet received a 
response from your school regarding the potential excess liquid capital in your school's 
Federal Perkins Loan Program for the 2002-2003 award year.

To review details of your notification, please logon to the eCampus-Based System web site 
at www.cbfisap.sfa.ed.gov. Select the "Self Service" link from the top navigation bar or 
main menu. Your data is posted in the "Campus-Based Notifications" section.

Sincerely,

The Campus-Based Programs

EM004, EM005

171 Select the <Close> button The report closes and the system displays the Communications page EM006

14



Self-Service Script
DRAFT
6/4/2002

Step: Value to Enter Expected Results Actual 
Results

Pass/Fail SIR# Test Conditions

172 Select the <Excess Cash Notification Letter> link on 
the Communications page

The e-mail displays:
MM/DD/YYYY]

Dear [FAA]: 
The U.S. Department of Education's eCampus-Based System has reviewed and responded 
to your school's reply regarding the potential excess liquid capital in your school's Federal 
Perkins Loan Program 2002-2003 award year.

To review details of your notification, please logon to the eCampus-Based System web site 
at www.cbfisap.sfa.ed.gov. Select the "Self Service" link from the top navigation bar or 
main menu. Your data is posted in the "Campus-Based Notifications" section.

Sincerely,

The Campus-Based Programs

EM004, EM005

173 Select the <Close> button The report closes and the system displays the Communications page EM006
162 Select the <Reponse Accepted - No Payment 

Notification> link on the Communications page
The e-mail displays:

[MM/DD/YYYY]

Dear [FAA]: 
The U.S. Department of Education's eCampus-Based System has reviewed and responded 
to your school's reply regarding the potential excess liquid capital in your school's Federal 
Perkins Loan Program 2002-2003 award year.

To review details of your notification, please logon to the eCampus-Based System web site 
at www.cbfisap.sfa.ed.gov. Select the "Self Service" link from the top navigation bar or 
main menu. Your data is posted in the "Campus-Based Notifications" section.

Sincerely,

The Campus-Based Programs

EM004, EM005

163 Select the <Close> button The report closes and the system displays the Communications page EM006
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Self-Service Script
DRAFT
6/4/2002

Step: Value to Enter Expected Results Actual 
Results

Pass/Fail SIR# Test Conditions

164 Select the <Response Denied- No Payment 
Notification> link on the Communications page

The e-mail displays:

[MM/DD/YYYY]

Dear [FAA]: 
The U.S. Department of Education's eCampus-Based System has reviewed and responded 
to your school's reply regarding the potential excess liquid capital in your school's Federal 
Perkins Loan Program 2002-2003 award year.

To review details of your notification, please logon to the eCampus-Based System web site 
at www.cbfisap.sfa.ed.gov. Select the "Self Service" link from the top navigation bar or 
main menu. Your data is posted in the "Campus-Based Notifications" section.

Sincerely,

The Campus-Based Programs

EM004, EM005

165 Select the <Close> button The report closes and the system displays the Communications page EM006
166 Select the <Response Accepted- Partial Payment 

Notification> link on the Communications page
The e-mail displays:
[MM/DD/YYYY]

Dear [FAA]: 
The U.S. Department of Education's eCampus-Based System has reviewed and responded 
to your school's reply regarding the potential excess liquid capital in your school's Federal 
Perkins Loan Program 2002-2003 award year.

To review details of your notification, please logon to the eCampus-Based System web site 
at www.cbfisap.sfa.ed.gov. Select the "Self Service" link from the top navigation bar or 
main menu. Your data is posted in the "Campus-Based Notifications" section.

Sincerely,

The Campus-Based Programs
 
 

EM004, EM005

167 Select the <Close> button The report closes and the system displays the Communications page EM006
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Self-Service Script
DRAFT
6/4/2002

Step: Value to Enter Expected Results Actual 
Results

Pass/Fail SIR# Test Conditions

168 Select the <Response Denied -  Partial Payment 
Notification> link on the Communications page

The e-mail displays:
[MM/DD/YYYY]

Dear [FAA]: 
The U.S. Department of Education's eCampus-Based System has reviewed and responded 
to your school's reply regarding the potential excess liquid capital in your school's Federal 
Perkins Loan Program 2002-2003 award year.

To review details of your notification, please logon to the eCampus-Based System web site 
at www.cbfisap.sfa.ed.gov. Select the "Self Service" link from the top navigation bar or 
main menu. Your data is posted in the "Campus-Based Notifications" section.

Sincerely,

The Campus-Based Programs

 

EM004, EM005

169 Select the <Close> button The report closes and the system displays the Communications page EM006
168 Select the <FCC Returned Notification> link on the 

Communications page
The e-mail displays:
[MM/DD/YYYY]

Dear [FAA]: 
The U.S. Department of Education's eCampus-Based System has reviewed and responded 
to your school's reply regarding the potential excess liquid capital in your school's Federal 
Perkins Loan Program 2002-2003 award year.

To review details of your notification, please logon to the eCampus-Based System web site 
at www.cbfisap.sfa.ed.gov. Select the "Self Service" link from the top navigation bar or 
main menu. Your data is posted in the "Campus-Based Notifications" section.

Sincerely,

The Campus-Based Programs

 

EM004, EM005
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Self-Service Script
DRAFT
6/4/2002

Step: Value to Enter Expected Results Actual 
Results

Pass/Fail SIR# Test Conditions

169 Select the <Close> button The report closes and the system displays the Communications page EM006
168 Select the <Title III Waiver Notification> link on the 

Communications page
The e-mail displays:

[mm/dd/yyyy]  
Dear [FAA]:  
The U.S. Department of Education’s eCampus-Based System has posted information 
regarding your school’s [2002-2003] Title III waiver.

To review details of your notification, please logon to the eCampus-Based System web site 
at www.cbfisap.sfa.ed.gov. Select the “Self Service” link from the top navigation bar or 
main menu.  Your data is posted in the “Campus-Based Notifications” section.    

Sincerely,  
The Campus-Based Programs  

EM004, EM005

169 Select the <Close> button The report closes and the system displays the Communications page EM006
166 Select the <Under Use Waiver Notification> link on 

the Communications page
The e-mail displays:

[mm/dd/yyyy]  
Dear [FAA]:  
The U.S. Department of Education’s eCampus-Based System has reviewed and responded 
to your school’s request for a waiver of the under use penalty for the [2002-2003] award 
year.

To review details of your notification, please logon to the eCampus-Based System web site 
at www.cbfisap.sfa.ed.gov. Select the “Self Service” link from the top navigation bar or 
main menu.  Your data is posted in the “Campus-Based Notifications” section.    

Sincerely,  
The Campus-Based Programs  

EM004, EM005

167 Select the <Close> button The report closes and the system displays the Communications page EM006
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Self-Service Script
DRAFT
6/4/2002

Step: Value to Enter Expected Results Actual 
Results

Pass/Fail SIR# Test Conditions

164 Select the <Community Service Waiver 
Notification> link on the Communications page

The e-mail displays:

[mm/dd/yyyy]  
Dear [FAA]:  
The U.S. Department of Education’s eCampus-Based System has reviewed and responded 
to your school’s request for a waiver of the Federal Work-Study community service 
requirements for the [2002-2003] award year.

To review details of your notification, please logon to the eCampus-Based System web site 
at www.cbfisap.sfa.ed.gov. Select the “Self Service” link from the top navigation bar or 
main menu.  Your data is posted in the “Campus-Based Notifications” section.    

Sincerely,  
The Campus-Based Programs  

EM004, EM005

165 Select the <Close> button The report closes and the system displays the Communications page EM006
170 Select the <Award Modifications> link on the 

Communications page
The e-mail displays:
[MM/DD/YYYY]

Dear [FAA]: 
The U.S. Department of Education's eCampus-Based System has adjusted your award 
authorizations for the 2002-2003 award year. Your Statement of Account serves as your 
notification.

To review details of your notification, please logon to the eCampus-Based System web site 
at www.cbfisap.sfa.ed.gov. Select the "Self Service" link from the top navigation bar or 
main menu. Your data is posted in the "Campus-Based Notifications" section.

Sincerely,

The Campus-Based Programs

EM004, EM005

171 Select the <Close> button The report closes and the system displays the Communications page EM006
172 Select the <Home> from the top navigation bar The Campus-Based Admin Page is displayed EM006
173 Admin Wants to Log Out of the System
174 Select the <Logout> link from the left navigation bar The System displays the log out warning message, there is a Yes and a No button. 

175 Select the <Yes> button The System displays the Log in Page
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